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Check that all lumber placed on bench, is out of the way of the trolley. Press the Yes
button to enable and home the Trolley and Saw.

Open a Job File
Click on the
File
dialog box

Button (or select "Open Job" from the File Menu ) to open the Open Job

Then Select the job and click "open"
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Main Screen
Shows the actual position
Of the trolley

Shows the position of the
saw.

The enable button
Allows you to turn
The power onto the
Servo drives.

The disable button
Allows you to turn
The power off to the
Servo drives.
The start button
Starts the member that
You are currently on.
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Auto
By opening the job from the job file, this will display the cutting information from the selected job. Select
the member from the list you wish to cut by touching that line or by using the arrow keys to scroll between
members. Once you have selected the member ensure the positioning servos are in enable the box next to
enable must be green. By pressing the start member button the saw and trolley will move to there desired
positions in preparation for the cutting of that member, once you have completed the first cut the saw will
move positions

Enable

Arrow keys

Semi
Semi allows you to create your own member with up to 6 angles and 4 offsets; it allows you to cut it in an
automatic way.
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MANUAL
Manual allows you to enter one angle and one length. By touching the white boxes either saw angle or
trolley position a keypad will apair allowing you to enter your desired position. The servos will then
position the saw or trolley to the positions that you have entered.

-File Menu

Copy Files From Removable Media:
This will copy the files from the removable media path selected in the Setup File Tab
Open Job:
This will open the Open file dialog box so that you can Open a Job File
Exit:
This will Shutdown the CSS software and return you to the windows desktop
Shut Down Computer:
This will Shutdown the CSS software and show the windows shutdown dialog box so that the
computer can be shutdown or restarted
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Tools Menu

Servos:
This will take you to the Servos Screen
Converter:
This is an imperial and metric Converter to convert from any units to another unit.

Options Menu

All options are enabled when the tick is next to the option
Clicking the option toggles the tick
The options are saved and will be recalled when the software starts
Auto Flip For Safest Cut:
This setting applies to trusses only and has no affect on plates.
The member will be flipped when the cut would be wedging the waste into the saw on the saws
return stroke.
Auto Swap For Easiest Cut:
This setting applies to trusses only and has no affect on plates.
The member will be end swapped when the first end cut is calculated to be harder for an operator
to perform than the other end. I.E. a single cut end will be the first cut if available
Under Cut Length 2mm:
All members will be undercut by 2 mm
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Auto Stop Saw When Marking:
This setting applies to Plates only and has no affect on trusses.
The saw will stop when the last cut is preformed on a member before any marking is started.
Some operators for safety when marking prefer this
Next Move Auto (when saw back):
When the saw is returned to the fully retracted position the saw and trolley will auto setup for the
next cut.
Next Member Auto (when mem complete):
When the member is fully completed (the qty required is cut also) then the next member in the list
will be selected for you. You will still need to click start member before the saw will setup for this
member
Auto Delete jobs over 30 days old:
When a job has not been accessed (opened or used for cutting) for over 30 days then the job will
be deleted from the job folder. (Set in the Setup File Tab)
For system safety the job folder must contain the string "jobs"(in any upper or lower case) before
auto delete will be performed.

Member menu

Flip Board vertically

Allows you to the member side for side.

Swap Ends Horiztally

Allows you to rotate member from end to end.

Toggle Done Status

Allows you to tag and untag members.
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Help menu

Help Menu contains a manual for onscreen Help

Accessing Setup
To Access the Setup screen click on the "Tools" menu at the top of the screen and then "Setup"
you will be prompted for a username and password.
When you click on the username or password boxes a Screen Keyboard will pop up so that touch
screen users can enter in the required information.
When you have entered the username and password click on the OK button to open up the setup
screen
The setup Screen consists of the following tabs:
Bench
Trolley
Saw
File
Colours
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Bench Tab

The Bench Tab enables you to set the following items up for your saw
Trolley Side:
When looking at the saw from the operating position this setting determines which side the trolley
is on in relation to the saw.
Display Units:
Metric or Imperial
This setting will determine how files are displayed on the screen regardless of how the file was
created or saved I.E. if a file is created in metric and you select Imperial here the file will be
converted and displayed in Imperial.
Saw to Plate marker:
This is the distance from the saw to the plate marker,
It is measured best after setting up and calibrating the saw and the trolley and then disabling the
servo and manually pushing the trolley up to the plate marker and reading the trolley position off
the screen and entering it into this box
Angle First cut waste:
This setting is used when drawing the member on the screen it has no affect on the cutting of the
members
Square First cut waste:
This setting is used when drawing the member on the screen it has no affect on the cutting of the
members
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Trolley Tab

The Trolley Tab enables you to set the following items up for your saw:
Soft Limits:
These are the upper and lower limits to the travel of the Trolley.
The trolley will be able to travel to these limits but not beyond during normal use
Home Position:
This is the measurement from the flange (or Motor) side of the saw blade to the Trolley pusher
after it has completed its homing sequence.
Positioning:
These settings control the speed and acceleration / Deceleration of the trolley
Also you can set the number of pulses per mm for the servo.
This is the number of encoder pulses for each mm of travel as is normally around the 299 setting
Manually setting this is not normally required as this will be set by the calibration procedure.
Changing this setting will affect the accuracy of all measurements of the machine and can cause
the Trolley to travel past the soft limits set above if set incorrectly
Tuning:
These should only be changed when instructed to do so by Spida machinery or Cyberlogix staff
serious machine damage and / or personal injury can result if these settings are changed by
inexperienced personal.
Calibrate:
This button will start and walk you through the Calibration of your trolley.
Use this procedure if your saw is not cutting accurately
NOTE: Make sure you reset and re-home the servos after any change
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Saw Tab

The Saw Tab enables you to set the following items up for your saw:
Soft Limits:
These are the upper and lower limits to the travel of the saw rotation.
The saw will be able to rotate to these limits but not beyond during normal use
Home Position:
This is the angle of the saw after it has completed its homing sequence.
Positioning:
These settings control the speed and acceleration / Deceleration of the saw rotation
Also you can set the number of pulses per Deg for the servo.
This is the number of encoder pulses for each Deg of travel and is normally around the 4144
Setting
Manually setting this is not normally required as this will be set by the calibration procedure.
Changing this setting will affect the accuracy of all angles of the machine and can cause the saw
to rotate past the soft limits set above if set incorrectly
Tuning:
These should only be changed when instructed to do so by Spida machinery or Cyberlogix staff
serious machine damage and / or personal injury can result if these settings are changed by
inexperienced personal.
Calibrate:
This button will start and walk you through the Calibration of your saw angle.
Use this procedure if your saw angles are not cutting accurately
NOTE: Make sure you reset and re-home the servos after any change
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File Tab

The File Tab enables you to set the following items up for your saw:
Default File Extension:
Select the most commonly used file extension for your site
Default Job Path:
This is the path that the operator will be taken to when they open a job, the operator can browse
to other locations but every time they select "open job" this folder will be selected.
We do not recommend you store your jobs on a remote machine
The Default is C:\SpidaJobs
For system safety the job folder must contain the string "jobs"(in any upper or lower case) before
auto delete from the options menu will be performed.
Removable media path:
This is the path to your removable media that you typically use for transferring jobs to this
computer.
When the operator selects "copy files from removable media" from the File Menu then all files in
this location will be copied into the default job path as specified above.
Options:
Use MME Compression:
Select this option to use the similar member compression available in the Mitek MME format (it
will have no affect for any other file types)
Swap member ends on load:
This option is mainly for plate marking. If the marks on the plate don't match the panel image then
this will reverse all plates on loading of the job
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Colours Tab
Used for changing the default colours in the job list
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Calibration

Saw Calibration:
To calibrate the saw angle Access setup and select the saw tab from their click on the Calibration
button and you will see the saw calibration screen. This calibration will adjust the "Pulses Per
Deg" on the saw tab
Trolley Calibration:
To Calibrate the Trolley Lengths Access setup and select the trolley tab from their click on the
Calibration button and you will see the trolley calibration screen. This calibration will adjust the
"Pulses Per mm" on the Trolly tab
Follow the instructions on the screen to Calibrate the saw or Trolly.
NOTE: Make sure that you reset and re-home the servos after any calibration changes

Saw

Trolly
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Servos
The Servos are the small motors in your machine that control the positioning of the Saw and
Trolly.
They are a very accurate device that can position their output shaft to within 0.1 Degrees. This
output is then run through a gear drive which increases the accuracy even further. There are
some mechanical losses in the belt drive and chain drives that control the actual position of the
saw and trolly but accuracy of 0.01 Degrees or better than 0.1 mm is still achievable on a wellmaintained system.
Calibration on the servos is preformed in the setup screen under the Trolley and Saw tabs

Enable:
This will enable the servo, when enabled a servo will maintain its position and effectively lock
onto the correct position.
The green light will indicate next to the Enable button when the servo is enabled
Disable:
When disabled you can move the trolley or saw by hand, the servo will feedback the position but
not control the position.
The green light will indicate next to the Disable button when the servo is disabled
Reset:
This will reset (and Disable) any servo drive faults
The Red light will indicate next to the Reset button to indicate a servo fault the servo drive in the
cabinet under the table will show a fault code to indicate the fault present (on power up the servo
will show a fault until the reset is pressed)
The Reset button will also setup the drive with the correct parameters when pressed, and this can
take a couple of seconds. You will not be able to enable the drive while this setup is being done.
Home:
This will home the servo to a homing proxy located on the machine.
Warning: the servo will move at a slower homing speed towards the homing proxy to locate a
known position (as setup in the Saw or Trolley tab of the setup screen).

The red light next to the Home button will change to green when the servo is homed.
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Warranty
SPIDA Machinery 2000 Ltd (“SPIDA”) 9 – 13 Scott St, Rotorua, New Zealand, warrants the
equipment listed below to the initial purchaser of the equipment only against defective
workmanship and materials only, for a period of twelve (12) months from the date of shipment
from SPIDA’s factory, subject to the following conditions:
1.
SPIDA extends the original manufacturers warranty to SPIDA on buy-in items such as
motors, saw blades and air cylinders or other such buy-in items but does not add its
warranty herein described to such items.
2.
This warranty only applies if:
a.
The attached copy of this warranty is signed by the initial purchaser and returned
to SPIDA’s address shown above within 14 days of shipment of the goods from
SPIDA’s factory.
b.
The equipment is installed by SPIDA or its licensed installer.
c.
Regular routine maintenance has been carried out on equipment in accordance
with instructions in manual provided by SPIDA and proper housing and shelter
provided for the equipment.
d.
The equipment is operated by competent personnel in accordance with the
operating instructions set out in the manual provided by SPIDA and not
otherwise.
e.
The equipment has not been subjected to alterations or repairs or dismantling
without prior written approval of SPIDA. Any parts returned to SPIDA either for
repair or consideration of a warranty claim consequent to an authorisation to
dismantle must be shipped prepaid.
f.
SPIDA may, at its option, either repair or replace the defective part upon
inspection at the site of the equipment where originally installed. The warranty
does not cover the cost of freight, Labour or traveling for the removal or
replacement of the defective parts.
g.
This warranty does not apply to any deterioration due to average wear and tear
or normal use or exposure.
h.
In all warranty matters, including any question of whether this warranty applies to
any claim, the decision of SPIDA is final.
This warranty is the only warranty made by SPIDA as the manufacturer and is expressly in lieu of
and excludes all other warranties, conditions, representations and terms expressed or implied,
statutory or otherwise, except any implied by law and which by law cannot be excluded. Neither
SPIDA or its agents or servants will be liable in any way for any consequential loss, damage or
injury including any loss of use, profits or contracts.
The law applicable to this warranty shall be the law of New Zealand and the parties hereto submit
to the exclusive jurisdiction of the Courts of New Zealand.
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Warranty

Date of Shipment

/

/

SPIDA Machinery 2000 Ltd

Ken Lines
Managing Director
Date

I acknowledge and accept the contents of this warranty.
Name:
Title:
Company:
Date:
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Training Certificate

INSTRUCTOR:
POSITION:
COMPANY:
SIGNED:
DATE:
I the undersigned declare that I have been instructed in the safe operation of this
Framemaster.
I declare that all the information in this document was
demonstrated and explained to me by the instructor. I further declare that I have
thoroughly read and understood the Operations Manual and additional notes.

NAME:
POSITION:
COMPANY:
SIGNED:
DATE:

Witnessed by:
NAME:
POSITION:
COMPANY:
SIGNED:
DATE:
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